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End User License Agreement (EULA)

Use of this product is subject to the acceptance of our End User License Agreement, available here.

©2022 UVI. All rights reserved.
All trademarks are the property of their respective owners.
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PX SunBox
Galactic Analog/Digital Hybrid Synth

• Inspired by the incredible German-born SunSyn
• 420 layers deliver a massive range of unique and inspiring sounds
• Explore hundreds of custom presets and create your own

INSPIRATION
The Best of Both Worlds
A feat of instrument design, the SunSyn is a fantastically complex-in-all-the-right-
places labor of love from German synthmaker JoMoX. Released in 1999, it can be 
considered in simple terms as an 8-voice polyphonic analog/digital hybrid, or in a 
more adventurous way as 8 discrete modular mono synths. Each voice is outfitted 
with 2 true analog oscillators capable of saw, square, or pulse with PWM, and 2 
guided digital oscillators with hundreds of waveforms and custom sample support.

Shape-Shifter
The filter section is equally impressive, with a morphable 4-pole true analog 
filter with discrete control over each pole’s cutoff frequency. But maybe the most 
groundbreaking aspect is the modulation matrix. In spirit it’s much closer to that 
of larger modular analog systems, allowing 4096 possible routings per element, 4 
elements per voice, all done in the analog domain. But unlike fully analog systems 
the modulation routings here can be quickly made through an interactive matrix 
and saved in patch memory for instant recall.

INSTRUMENT
Resurrecting a Sun
Working with such a complicated instrument has its challenges, especially given 
its age and limited production. Many parts for the SunSyn are extremely rare 
and almost impossible to source. In our case, to complete the servicing and 
refurbishment our tech had to purge parts from a second unit. An expensive 
and somewhat painful process but worth it in the end, as our sound designers 
headed off to work on a fully-restored and perfectly calibrated instrument with 
factory-spec parts.

Deep Sound Design
Sound design possibilities on the SunSyn are nearly endless, and the results of our 
process with it are evident. From massive, rich, and evolving polysynth sounds 
created in multi-mode, to devastating and aggressive monosynth sounds utilizing 
modulations of both analog oscillators, the digital RCOs, and filter morphing. 
We designed and recorded hundreds of multisampled soundsets, ending with 
a curated selection of 420 layers, delivering what we think represent the most 
unique, charactered, and sometimes epic, sounds possible on this machine.

Professional Presets
Bass, Bells, Brass, FX, Keys, Leads, Native Sequences, Organ, Pads, Percussive, 
Plucks, Polysynth, Strings, Sweeps, Voices, Waveform Analog, Waveform Digital, 
over 452 all-new + custom designed presets are available, built from a library 
of 30,660 authentic hardware samples. All presets are fully-editable, meaning 
you can deeply customize them or evey create your own. And the dual-layer 
architecture of PX SunBox allows you to easily create incredible layered tones 
from any combination of the included sounds.

Fully-Editable Architecture
PX SunBox gives you a deep and capable toolset for creating and editing patches. 
From the dual-layer architecture with ADSR amp envelopes, multimode filters 
with envelope, poly or mono modes with glide, pitch shifting and advanced 
stereo modes, and handy modwheel mappings, to LFO and step modulators, 
two feature-rich arpeggiators, and a generous selection of high-quality effects 
including 3-band EQ with sweepable crossover, drive, Thorus, ensemble, Phasor, 
digital delay, and Sparkverb.

Feel the Heat
An absolutely tremendous library of new sounds packed in a versatile and 
deeply-editable instrument, explore the incredible hardware tones of a uniquely 
ambitious hybrid German synthesizer with PX SunBox.

PROTOTYPE SERIES
PX SunBox is part of the PX line of instruments, exploring the world of unique, rare 
and sometimes unreleased electronic and acoustic instruments

Minimum System Requirements
• Latest version of UVI Workstation or Falcon
• 4.88 GB of disk space
For more information on the installation process, please refer to 
the document: Soundbank Installation Guide

Introduction

http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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Main Page and Globals

Amplitude

Filter

5

6

Master Volume1

Layers / Programs 3

Edit Layer 4

Pages 2

1  Master Volume

2  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

3  Layers / Programs (1 / 2)
» Power

Turn layer on/off

» Program

Click ‘Layer’ LCD to change program via 

drop-down menu

» Preset

Change program with ◀▶ bottons

» Volume

Adjust layer volume

» Pan

Adjust layer pan

» Level meter

Displays layer output level

4  Edit Layer
» Select: 1 / 2 / 1+2

Select 1, 2 or 1+2 ; presents per-layer 

control for Amplitude and Filter sections

5  Amplitude
» Velocity

Toggle velocity on/off

» Vel > Atk

When active, routes Velocity input to 

Amp Env: Attack

» ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

6  Filter
» Mode

Select between LP, BP or HP filter 

shapes, or OFF to disable the filter

» Frequency

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter depth

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Adjust the filter using a typical Attack, 

Decay, Sustain, Release envelope

PX SunBox is outfitted with 2 layers; 1 and 2. Both layers have independent selection of 420 sound programs, dedicated volume, pan, filters, envelope gener-
ators for amplitude and filter, and arpeggiators in the Arpeggiator page. Effects pages affect the summed signal of both layers while Modulation can be set to 
selectively target layers 1, 2, or 1+2.

http://www.uvi.net/
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Edit Page

Pitch3

Stereo4

Modwheel5

Voicing2

Edit Layer 1

1  Edit Layer
Select 1, 2 or 1+2 ; presents per-layer 

controls for Voicing, Pitch, Stereo and 

Modwheel sections

2  Voicing
» Mode

Toggle between Mono and Poly voicing

» Time

Set the Glide time

» Depth

Adjust the Portamento depth

3  Pitch
» Semitone

Adjust the pitch in Semitones

» Octave

Adjust the pitch in Octaves

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Adjust the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples

5  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate, and Filter 

Depth

http://www.uvi.net/
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Modulation Page

Step Modulator 1

1  Step Modulator
» Steps

Change the number of playable steps 

(1-16)

» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Average

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

» Step Modulator Target

Control the amount of modulation to be 

applied to each or both layer’s Volume 

Amount or Filter Depth

2  LFO
» Sync

Enable/Disable LFO sync to Host Tempo

» Speed

Change the LFO Speed

» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square, or Sample & Hold

» LFO Routing

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume, and Filter

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger, or Legato

» LFO Target

Control the amount of modulation to be 

applied to each or both layer’s Volume 

Amount, Filter, and Pitch Depth

3  Modulation Targets
Set the target layer for the parameter 

modulation, layer 1 and/or 2

Modulation Targets3

LFO2

http://www.uvi.net/
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Effects Page

1  Equalizer
» Power

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency (▶f◀)

Set the crossover frequency point 

between Low/Mid and Mid/High bands

2  Drive
» Power

Turn the effect on/off

» Amount 

 Adjust the drive amount

3  Thorus
» Power

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

4  Ensemble
» Power

Turn the effect on/off

» Mode 

 Set the ensemble effect mode

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

5  Phasor
» Power

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

6  Delay
» Power

Turn the effect on/off

» Time 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

7  Sparkverb
» Power

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» Decay: LoMult 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» Decay: HiMult 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount

Drive 2

Digital Delay 6

Ensemble 4

Phasor 5

Sparkverb 7

Equalizer 1

Thorus3

http://www.uvi.net/
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Arpeggiator Page

Speed6

Steps7

CC9

Octave10

Gate8

Arp Mode 5

Arp On/Off 4

Arp Preset 1

Per Step Edit 2

Link 3

1  Arp Preset
» Preset

Select the preset by clicking the lCD 

screen , or using the ◀▶ bottons

» Load

Click to load a user preset

» Save

Click to save the current settings as a 

user preset

2  Per Step Edit
» [STEP] Step Indicator

LED lights up when step is triggered

» [VEL] Step Velocity

Freely draw note velocities

» [TIE] Step Tie

When active, step inherits Velocity from 

the previous step

» [MODE] Step Mode

Set the step mode (Single or Chord)

» [SEMI] Semitones

Set the step pitch shift value

» [PAN] Pan Position

Set the step pan

» [GATE] Gate Length

Set the step gate duration

» [CC1] MIDI CC1 Value

Set the step CC1 modulation value

3  Link 1+2
When enabled both layers listen to Arp 1

4  Power
Toggle the Arpeggiator On/Off

5  Arp Mode
Select Up, Down, or Up and Down

6  Speed
Change the step duration (1/32 - 1/1)

7  Steps
Set the number of playable steps (1-16)

8  Gate
Change the step length (from zero to the 

tracks Resolution setting)

9  CC
Enables MIDI CC output

10  Octave
Set the pitch range in Octaves

http://www.uvi.net/
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Preset List

00 Sunbox Basics
00 Init
Bass Mono Mode
Bass Poly Mode
Bells Stereo Alt
Brass Basic
Brass Unison
Keys Template
Lead Mono Mode
Lead Stereo Double
Organ Basic
Pad Basic Unison

Pad Stereo Double
Pluck Stereo Alt
Poly Mono
Poly Unison
Strings Unison

Animated Arp
Amiral Boat
Beau Jiden
Box Sun Arp
Dark Swan
Day One
Drake Star
Dry Dual Arp
Expressive FX
Jo Culbuto
Light And Sun
Marching Robot
Multipla1000
Punker Cyb
Quadrasonic
Resonoising
Rosa Nalog
Sunboxing
Symphonoisy 1
Symphonoisy 2
Tanger Arp 1
Tanger Arp 2
TB Yourself
Tiny Toons
TV Arp Strings
Ultrasons
Venice Night
Xtorsions

Animated Mixed
Call Me Wheel
Daddy Step
Galopluck
HP Pattern
Jean Germanix
K4000
Mayhem Tronic
Medecine 1
Medecine 2
Money Break
Moro Dafter

Move On Wheel
Oiseau De Feu
Pad Frica
Pad Noise Arp
Pandora Box
Philtausorus
Plain Synth Wheel
Pluck Automate
Power Horse
Rendez Vous
Running Organ
SimpLFO
Simplicity
Solo Seqo
Space Clouds
Space Farandole
Special K
Step N Arp 1
Step N Arp 2
Step Sweep
Sub Phaser
Submarine
Tarava
Victoria
Wheel Dark
Xmas Seq

Animated One Key
Chilloop
Crispy Sun 1
Crispy Sun 2
Cyber Flamenco
Frantic Mod
Ginger Bard
Itch Art
Jotox Mox 1
Jotox Mox 2
Little Monsta
MeditaSun

Mireille Dark
Miss Tuba
Nate Reso
Poulpe Friction
Punk Pursuit
Sample Guitars
Sample Voxer
Sean Ballec
Seq Hence
Space Bambatta
Sub Seq 1
Sub Seq 2
Super Copter
Tonio Sport
Trash Can
Vince Finger
Vocasonic
War Of Bots
Wiki Wiki

Bass
Analog Sun 1
Analog Sun 2
Chip Tune Bass
Disco Sun
Electro Funk
Electro House
Gettho Daft
High Rez Bass
J Low
MikaLow
Morph Seq 1

Morph Seq 2
Move Da Bass
Nuclear Switch
Octave Seq 1
Octave Seq 2
PhatosC
Power Rangers
Punk Cyb Seq 1
Punk Cyb Seq 2
Rez On Wheel
Simple Power
Slap FM
Solar Cream
Stack Sun Bass
Steve Octave
Stick On Vel
Subrass
Sun Bass Seq 1
Sun Bass Seq 2
Sun Bass Seq 3
Sun Bass Seq 4
Syncotropia
TimpaSuny 1
TimpaSuny 2
Trap Beach
Triplet Waves 1
Triplet Waves 2
Ultra Drone
Vel Fake
Wheel Da Drone
Wheel Diplosonic

Bells
Aladine
Bellsun 1
Bellsun 2
Body Gital
Delicate
Digital Bells 1
Digital Bells 2
Disco Bells
Ethic Bells
Glide Analog
Harpish Bell

High FX
Metalic
Mini Carillon
Modulations
Mono Bass Bells
Music SunBox
NoiSun Bells
Organ Bells
Paradisio
Phasofter
Pure Anabella
Pure Xmas 1
Pure Xmas 2
Raining Bells
Royal Jelly
Slightly Detuned
Slow Attack
Smove
Sunsyn Ana Bells
Sunsyn Dirt
Sunsyn Zapish
Synth Gamelan
Tangerine Bells
Wood Bells
Words Celia

Brass
Animated Horns
Big Dark Brass
Combo Sun
Creative Brass
Funky Stab 1
Funky Stab 2
Horns Shot LFO
Karmarp
Kortex
Low Range
Mod Brass

More Than Full
Reso Brass
Sax Ensemble
Short N Long
Soft Sun Brass
SolHorns
Stacked Brass
Supa Glide
Super Creative
Syn Trumpets
Ultra Soft Horns
Woodwindish
X Brassun
Yvan Gelis

FX and More
Abstract Reality 1
Abstract Reality 2
Electro Heart
Insect Vasion
Metal Dolphin
Metal Forest
Motor Bass FX
Multi Vox
Play Da Noise
Radio Dance
Radipad
Randomas
Space Bird Army
Space Bug
Stereoid
Still Musical 1
Still Musical 2
Sun Cave 1
Sun Cave 2
Surfin Cycle
Sweep Modded
Synth FX Machine
Too Long Verb
Verbstorsion
Wheel Halen
Zebulon Box

http://www.uvi.net/
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Preset List

Keys
Acoustic Maze
Beauty Noisy
Dark Web
Deep Keys 1
Deep Keys 2
Deep Keys 3
Dirty Soft Keys
Dream Piano
Electric Grand
Harpsi Low
Harpsibrass

Harpsitron
Huge Keys Organ
Jom Clav
Key Box
Large Tines
Long Animated
Lost In Verbania
Moelleux Ochoc
Mon Dyno
PWheelM Soft
Smooth Keys 1
Smooth Keys 2
Space Baroque
Stacked Piano 1
Stacked Piano 2
Sun CP
Sunny FM Keys
Suntoy Piano
Tanger Keys
Trash Clav 1
Trash Clav 2
Vapor Keys
Waterland

Leads
A Lead Baba
Daftology
Dirty Bass N Melo
Dreamlead
Dualead
Frantic Analog
Frantic Modular
Kyoto Matic
LA Cigogne
Larsenoisy
Lead Powa

Leadisto
LFOw Monow
Megadrive
Mono Bi Gout
Nicolead
Octavax
P Funk One
Panned 1 Basic
Panned 2 Harder
Panned 3 Mod
Picolead FX
Poly 80s
Poly Pure Sun
Propaganda
Pure Lead
PWMania
Sample N Hold
Scream Verb
Sgritty Policy
Slow Env Noise
Smooth Lead 1
Smooth Lead 2
So High
Soloctav
Subscription
Sunny Funky
Vox Hollow
Wha Rez
Wheel Digital
Whistle Wheel

Organ
Beauty Pipes
Crystal Church
Jazz Box
Lunar Pad
Manege Turn
Milano
Open Door
Perc Low Organ 1
Perc Low Organ 2
Reggae Sun
Singulorg

Smooth Caroussel
Softy Moddy Perc
Space Manoir
Sun Church 1
Sun Church 2
Tiny Trash Org

Pads
Dark X Mas
Double Layer
ExpressiVel
FX Bell Pad
Huge 1
Huge 2
Jarre Michel Jean
Kaoss Dispersion
Leospheric
Lituania
Low Beauty
Madagascar
Magnifique
Mallow Cat
Multiplex
OBservor
Padeep
Pole Nord
Pole South
PxNL Mood
Quasi Fantasia
Rawminous
Sahara
Saturn
Seq Ollen Royal
Spacial Sea
Split Spectral
Stress Man
Subtility
Ultra Lush
Vel To Bell
Wet Wet Wet
Wheel Me SPA

Percussive
Galago
HH Loop
Kick And Snare
Oizo
Pitched Perc 1
Pitched Perc 2
Sun Kick Seq 1
Sun Kick Seq 2
Sun Kick Seq 3
Suntribe
Tom Dom

Pluck
Anthemic
EPluck
Fluty Plucky 1
Fluty Plucky 2
Large Stacc
Low Vel Noise
Mallet Vox
Noise Floor
Organ Power
PLHook
Pluck N Vox
Pluckreative
Roomate
Seq Pluck 1
Seq Pluck 2
Seq Pluck 3
Slow Ambient
Stack Box
Sun Pluck
Supa Plucka
Tropical
With Arp

Polysynth
Analog Stab
Digital Scream
Eighties Eye Fix
Flutish Nap
Flutron Wheel
Gliss Erin
Granular Pluck 1
Granular Pluck 2
High Bride
Icelander
Insecticide

Interfere
Lil Rob
Long Dirty Delay
Low Force Op
Low To High
Lunaraw
Malcom XXL
Mega Sweep
Modulo Four
Native LFOs
Orchestral Mood
Phase From Heart
Phonk Phase
Poly 87
Poly Noise
Power Force
Quasi Vox
Release It
Stack Gate
Stack Organ
Stepolix
Synthy Lauper
Vochaos Wheel
Yannification

Strings
Electro Pop Strings
Ensemble Coms
Express Hybris
Fan Cells
Lush Vanesss
Marcasys
Phaedrs
Phasominous
Pizzicabox s
Pizzicabox s
Slow Lee Woos

So Real Stacs
Solins
Stacreativs
Strings Bos
Sunboxestrs
Super Expressive s
Super Expressive s
Surprisins
Tremolo Bos

http://www.uvi.net/
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Layer Program List

Bass
Analog Sun 1
Analog Sun 2
Delayed LFO
Diganalog Bass
Fake Electric
FM Aliasing
FM Like Bass
FX Bass 1
FX Bass 2
Gliss Erin
Kilkorg

Low Force Op
Mougue Dark
Mougue Power
Move Da Bass
Moving Bass Road
OB Raw
Pad Bass
Random Filter
Raptor Blast
Reso FX Sub
So Michael
Square Double Bass
Square Filter
Sub Double Bass
Sub Syn
Subby Sun
Sun Bass 1
Sun Bass 2
Sun Bass 3
Supa Noise
Tom Fat
Vox Attack
X Brutal
X Low
Zap Hard
Zap Soft

Bells
Digital Bells
Digitalizer
Heaven Like
Moving Bell Bright
Moving Bell Soft
Noisabel
Parabellic
PWMetal
Sun Dirty Bells
Sunshine
Synth For Bell

Tiny Bell
Unperfect Bells
Zavan Garde
Zodiac Bells

Brass
Brassun
Creative Brass
Elle Est Saw
Funky Fresh
Funky Stab
LF Horns
Muted Ensemble
Power Sun Brass
Reso Brass
Ring Brass
Slow Env Brass
Soft Sun Brass
Solhorns

FX
D Two R Two
D Two R Zen
Detuned Pad
Double Vox
Electronic Sphere
Ghost Sunlight
Gritty Policy
Jack Turbino
Kaoss Dispersion
Krazy Filter
Leospheric

Mal Demer
Mayhem of Sync
Melle FX
Monster Fun
Nuclear Bomb
Pigs In Space
Pigs In Sun
Porta Synchord
Radio Frequence
Silver Surfer
Sonar FX
Space Bug
Starship SAS
Sun Machinery
Synth Lick
UFOlie
Unharmonic Bell
Xpad Chopper
Zap To Mod

Keys
Analogikeys
Deep Keys 1
Deep Keys 2
Deep Keys 3
Dirty Soft Keys
Falling Keys
FX Rez Keys
Hard Keys
Hardigital
Hardirty Keys
Harpsilog

Huge Harpsichord
Jom Clav
Keys Of Sun
Klavel Cycle
Kreatine Clav
Lunar Keys
Pianissimo
Piano Cheez 1
Piano Cheez 2
Piano Synth LFO
Smooth Keys
Sombre Piano
Sun CP
Sun Tines
Talking Keys
Typicanalog
Zordyno

Leads
Da Funk
Dirtronic
Fifth Attack
Fifth Smooth
Future Retro
FX Lead
Harmonicash
Lead To Bass
Like Daft
Metallead
Mosquito
Nicolead
Normalead
Pan Flute Noise
Retrogamer
Scream LFO
Space Busy
Space In Dark Vador
Sync Seq
Syncapour
Whistle Battle

NATIVE SEQ
Drunk Robot
Gate Fifth
Guitar Lick 1
Guitar Lick 2
LFO Seq 1
LFO Seq 2
Native LFO 1
Native LFO 2
Native LFO 3
Native LFO 4
Pluie De Note

Organ
Farfibroken
Gospel Jam
Perc Hi Organ
Perc Low Organ
Pluckish
Smooth Organ Soft
Softy Moody
Space Church
Sun Full Organ
Synth Organ
The Doors
Violet Organ

Pads
Beauty Step
El Padrone
Flutish Nap
FX Rez Pad
German Drone
Ice Noise
Interfere
Lituania
Long Anissa
Lots Of Things
Lunar Pad

Mario Sunsyn
Metaloid
Minimal Phase
Noise Beauty
Padyno
Particules
PNL Mood 1
PNL Mood 2
Russian Mountain
Sahara
Saturn
Seq To Pad
Slow Sync 1
Slow Sync 2
Softy Paddy
Syn Arborigen
Tubissime
Zen Cycles

http://www.uvi.net/
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Layer Program List

Percussive
8o8 Cowbell
Analog Zap 1
Analog Zap 2
Djembetronic
Gongtronic
Long Fall
Machine Clap 1
Machine Clap 2
No Note Bell 1
No Note Bell 2
Noise Attack

Noise Note
Non Harm Perc
Ride Analog
Steel D Noisy
Synpani
Synth Cymbals
Tablatronic
Tchiki Perc
Tommy Records
Tonal Snare
Tron Perc 1
Tron Perc 2
Wood Syn

Pluck
Fifth Pluck
High Pluck 1
High Pluck 2
High Pluck 3
Little Reso
Mellow Pluck
Native Delay
Noise Move
Pluck And Pad
Pluck Organ
Pop Noise Corn
Shorta Bella
Slapluck
Square Enoise
Square Seq Hard
Square Seq Soft
Sun Pluck
Thinny Sweepy
Trick Elec

Polysynth
Analog Stab
Insecticide
Jupiter Soul
Laupering
Lunar Poly
Moving Pole
Parasynth
Phat Mosfer
Phat One
Poly 5th
Poly Noise

Polyference
Polysun
Slow Env Poly
Slow Gim
Space Bubbles
Sun Poly
Sun Stack
Synth Di Laup
Synthetish

Strings
Cellotronic
Machine Strings
Metal Strings
Odyssey
Slow Env Strings
Slow Strings
Solina Dirt
Spar A Site
Strings DX
TV Strings

Sweeps
Fast Sweep In
Mellow Ten
Musical Noisweep
Noise Sweep Organ
Stepped Mahyem
Sun Filters
Sweep No Rez
Thin Line

Voices
Formanta
Oswald
Poly And Voice
Rahoss
Sample Vox
VocaLFO
Vocalmos

Waveforms Analog
Basic

Noise Pink
Noise White
Saw 4
Saw 8
Saw 16
Square 4A
Square 4B
Square 4C
Square 4D
Square 8A

Square 8B
Square 8C
Square 8D
Square 16A
Square 16B
Square 16C
Square 16D

Double
Double Saw 4
Double Saw 8
Double Saw 16
Double Square 4A
Double Square 4B
Double Square 4C
Double Square 4D
Double Square 8A
Double Square 8B
Double Square 8C
Double Square 8D
Double Square 16A
Double Square 16B
Double Square 16C
Double Square 16D

Mixed
Saw 4 Square 16B
Saw 4 Square 16D
Saw 8 Saw 4
Saw 8 Square 16B
Saw 8 Square 16D
Saw 16 Saw 4
Saw 16 Saw 8
Saw 16 Square 16B
Saw 16 Square 16D
Square 4A Square 4B

Square 4C Square 4D
Square 8 Square 4A
Square 8 Square 4B
Square 8 Square 4C
Square 8 Square 4D
Square 8A Square 8B
Square 8C Square 8D
Square 16 Square 4A
Square 16 Square 4B
Square 16 Square 4C
Square 16 Square 4D
Square 16 Square 8A
Square 16 Square 8B
Square 16 Square 8C
Square 16 Square 8D
Square 16A Square 16B
Square 16C Square 16D

Wavetables Digital
Basic

WT Bass 01
WT Bass 02
WT Bass 03
WT Bass 04
WT Bass 05
WT Bass 06
WT Bass 07
WT Bass 08
WT Bass 09
WT Bass 10

WT Bass 11

Bellish
WT Bellish 01
WT Bellish 02
WT Bellish 03
WT Bellish 04
WT Bellish 05
WT Bellish 06
WT Bellish 07
WT Bellish 08
WT Bellish 09
WT Bellish 10
WT Bellish 11
WT Bellish 12

Formant
WT Formant 01
WT Formant 02
WT Formant 03
WT Formant 04
WT Formant 05
WT Formant 06
WT Formant 07
WT Formant 08
WT Formant 09
WT Formant 10

Noisy
WT Noisy 01
WT Noisy 02
WT Noisy 03
WT Noisy 04
WT Noisy 05
WT Noisy 06
WT Noisy 07
WT Noisy 08
WT Noisy 09
WT Noisy 10
WT Noisy 11
WT Noisy 12

Organ
WT Organ 01
WT Organ 02
WT Organ 03
WT Organ 04
WT Organ 05
WT Organ 06
WT Organ 07
WT Organ 08
WT Organ 09

Sinus
WT Sinus 01
WT Sinus 02
WT Sinus 03
WT Sinus 04
WT Sinus 05
WT Sinus 06
WT Sinus 07

Sunriz
WT Sunrez 01
WT Sunrez 02
WT Sunrez 03
WT Sunrez 04
WT Sunrez 05
WT Sunrez 06
WT Sunrez 07

Tines
WT Tines 01
WT Tines 02
WT Tines 03
WT Tines 04
WT Tines 05
WT Tines 06
WT Tines 07
WT Tines 08
WT Tines 09

http://www.uvi.net/
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

UVI Portal .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  uvi.net/uvi-portal 

Soundbank Installation Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . installing_uvi_soundbanks_en.pdf 

UVI Workstation User Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uviworkstation_user_guide_en.pdf 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 
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